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The following manual describes the steps to install the Digital Check SmartSource scanner and the 
associated Demo Program.   

1) Guide Change History 
 
 
 

Version Date Changes 

   

9.3.8 June 2019 Start Clean Button for scanners that support cleaning 
mode. 
LED pull-down menu for scanners with an application 
LED. 
Feeder Options: The “Cleaning Recommended 
Document Threshold” can be modified. 
 

   

9.3.6 December 2018 Pre-Config:  

1) The blank entry is now labeled Defaults.  

2) A new Receipt option is available that will 

print a sample receipt.  

3) The IDCard option captures Color JPEG 

images. 

4) The list is reordered so that the most 

popular options appear at the top of the 

list.   

   

9.3.2 April 2017 Feeder Options: A single feed operation can now 

be selected. 

   

9.3.1 April 2017 Feeder Options: Professional Elite and Micro 

Elite scanners now support a “Feed Any” mode, 

where items can be processed from either the 

primary entry or the ID Card entry. 

   

9.3.0 November 2016 The Demo now supports Expert scanners. This 

document has been rebranded to Digital Check 

   

9.1.2 January 2015 The Demo now defaults to enhanced quality for 

front and rear images. 

 

The Demo now defaults to automatic flipping 

and rotating of front and rear images. 

 

The Pre-Configured Endorser demo selection 

now endorses an auto-incrementing sequence 

number as well as the current date and time. 
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When the Demo software is installed via the 

DigitalCheckDemoSetup.exe installer, the 

following enhancements are enabled in the 

\Patching\device.ini file: 

 Image brightness and contrast are 

enhanced. 

 The JPEG quality settings are obtained from 

\Patching\device.ini, not from the Image 

Options settings in the Demo program. 

 Enhanced CCITT thresholding settings for 

Regions-of-interest are enabled for four 

sample documents defined in the 

\Patching\AltTDocs.txt file. 

 The perfectly-overlapped double document 

algorithm is enabled for all scanners. 

   
9.0.2 June 2013 Image file names changed - the third character 

changed from a period (.) to an underscore (_). 

 

9.0.1 April 2013 ID Card operation for SmartSource Elite: Pre-

Config and Feeder options. 

 

9.0.0 September 2012  Initial revision. 

   

 

2) Hardware Unpacking and Setup 
 
Click on the following hyperlink to view the SmartSource Open Professional Series hardware unpacking 
and installation video: 
 

Hardware Setup Video 
 

Below is a picture of the back of the scanner and how to make the necessary cable connections.  This 
should not be completed until the Demo Program has been loaded on the PC. 

 

http://www.burroughs.com/supportvideo.html?vidurl=http://www.youtube.com/embed/0mqUOtR1oMw
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3) SmartSource Demo Software Setup Instructions 
 
Make sure the SmartSource is turned off and the USB cable is disconnected before beginning the 
install of this package.   
 
Run “DigitalCheckDemoSetup.exe” as administrator to install the USB driver and the Demo program. At 
the end of the install, you will be prompted to reboot the PC. Once the PC is restarted, the setup of the 
demo program will be completed.  Make sure the SmartSource scanner is turned off and plug in the USB 
cable or the Ethernet cable to the PC.  Turn on the SmartSource. For USB scanners, the PC will indicate it 
has found a new USB device, then display “SmartSource Pro/Value” and finally load the associated USB 
Drivers.  You will see this screen: 
 

 
 
 
 

4) SmartSource Demo Software Operation 
 

a. How to Start the Demo 
 
Check if there are any applications running that might use the SmartSource device (e.g. SmartSource 
CAPI) and terminate those applications. 
 
Double click on this Desktop ICON that you created during the Demo install to start the Demo 
application. 
 

 
 

If you get the Security Warning message, just click “RUN”. 
 

 

b. Scanner Selection 
 
When the program begins, the following scanner selection screen is displayed: 
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 USB scanners: Select Professional/Elite and click OK.  
 
Ethernet scanners: Select Expert/Elite. Type the IP address of the Ethernet scanner in the Sorter 
Identifier field, type the IP address of the network card that the scanner is attached to in the IP Address 
Base field, then click OK. If the Ethernet scanner fails to connect, make sure incoming TCP traffic on 
ports 50001-50009 is enabled in the firewall on the SmartSource Demo PC.
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c. Overview of Demo Window 
 
Once you’ve selected a scanner, the following main screen will display.  A description of each section 
follows. 
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i. Start Scan Button 
 
Click on this button to start the scanning operation.  By default, automatic detection of items is enabled.  
Therefore when the operator puts items in the hopper, the scanner will automatically begin to feed 
items. There may be a slight delay the first time the Start Scan Button is pressed. The scanner firmware 
is downloading and initializing during this time. 
 

ii. Stop Scan Button 
 
By clicking on this button, the scanning process will stop.  The operator can click on Start Scan Button to 
start flow again.  Once the Stop Scan Button is clicked, the Clear Button and the Options Menu are 
available for use.   
 

iii. Start Clean Button 
 
Click on this button when the hopper is empty to initiate a cleaning operation, if the attached scanner 
supports cleaning mode.  The operator can then insert the cleaning card. 
 

iv. Clear Button 
 
This option is enabled when the Stop Scan Button had been clicked.  Clicking the Clear Button will clear 
the current image captured and the item journal. The item counter will also reset back to 0. Since the 
image file name has a fixed format based on the item count, the previously stored image file will be 
overwritten by the new items. To avoid this, the operator should specify his/her subfolder name 
between each batch run so the images will be saved in different location. 
 

v. Clear Track Button 
 
This button can be used to try to clear the track in case of a jam.  It will initiate the scanner to try to 
eject any items left in the track. By default, the “SmartClear” button on the top of the scanner is 
disabled and the scanning will resume when documents are in feeder. If the “SmartClear” button is 
enabled through the Feeder Options by un-checking the “Disable start button” and setting the 
“Autofeed timeout” to 0, the operator will need to press the “SmartClear” button to start flowing 
documents. 
 

vi. Message 
 
This displays informational, warning and exception messages. 
 

vii. Pre-Config 
 
The Pre-Config selections offer the pre-configured settings for device features that the operator can 
select and run without manually setting the options through the Pull Down Menu. Typically, one Pre-
configuration selection demonstrates one device feature.  



                                      SmartSource Demo Installation and Operation Guide v9.3.8 
 

                                                                                                                         Page 10 
 

Below are the currently available pre-configuration options: 
 

 Defaults 
This configuration restores the scanner to its default settings: Reader1 MICR, 240 dpi Front and 
Rear CCITT, 240 dpi Front Grayscale JPEG, and 120 dpi Front and Rear Grayscale JPEG images. 

  IDCard 
This configuration sets the feed mode to allow the operator to insert documents via the ID Card 
Entry point in the back of the SmartSource Elite. Front and Rear 300 dpi color JPEG images are 
captured. 

 Receipt 
This configuration uses an Arial TrueType font (for scanners that support TrueType fonts) to 
print a sample receipt: four lines of endorsement along with a Digital Check logo. The current 
date/time is endorsed. 

 MOCR 
This configuration enables three readers in the Reader Options so that Reader1 returns the 
combined MICR and OCR code line result, Reader2 returns the OCR code line result and Reader3 
returns the original MICR code line result. 

 Endorser 
This configuration uses an Arial TrueType font (for scanners that support TrueType fonts) to 
print four lines of endorsement along with the Digital Check logo. A document identification 
number and the current date/time are endorsed. 

  Barcode 
This configuration allows Barcode reading. A sample Barcode Demo document is shown at the 
end of this guide.  

 UV 
This configuration is set for scanning UV documents. UV capable device hardware and special 
UV documents are required to run. 

 OCR-A/B 
This configuration sets the reader for OCR-A and/or OCR-B documents.  A sample OCR-A/B 
demo document is shown at the end of this guide. 

  Tape Spooler 
This configuration requires the operator to press the “SmartClear” button on the top of the 
scanner to capture the rear image of the Adding Machine Tape. 

 Enhanced B/W 
This configuration darkens the captured front image by setting a negative threshold value in 
Image Options. 

 Color JPEG 
This configuration demonstrates the device’s color image capability by capturing 240 dpi Front 
and Rear Color JPEG, Front and Rear CCITT, and Front Grayscale JPEG images. 

 Franker 
This configuration demonstrates the device’s stamp/frank printing capability when the device 
hardware is enabled with the feature. 
 

 
Note:  If the device hardware is not configured with the pre-configured feature, the “Pre-configured 
feature is not present on the device” warning message will be displayed in the Message area. 
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viii. Item Counter 
 
Displays the number of items captured in the current transaction or run.  This counter can be reset by 
the use of the Clear Button. 
 

ix. Item Journal 
 
This shows a listing of the all the MICR code lines for each item captured during scanning.  You can click 
on a code line to display the image of the associated item.  Also, the up and down arrows keys can be 
used to quickly navigate up and down the list of items. The display list contains a maximum of 500 items. 
When flowing more than 500 items, the document count will keep increasing but the item journal list 
box will only display the last 500 items. Since all images are saved to disk at run time, you can find the 
older items in the image storage folder.  

x. Current Processed Image 
 
This shows the current image that has been captured by the Demo.  This can be changed by selecting 
another item in the item journal or clicking on a different image thumbnail of the current item to see 
one of the other three images available. 
 

xi. Image Thumbnails 
 
By default, four images are captured at burst track speed during the scanning process.  These are CCITT 
(black and white) front and rear along with Grayscale (JPEG) front and rear.  All four image thumbnails 
are shown in this order.  By clicking on another image thumbnail, the image rendition of the current 
item will display.  You can tell which image is selected as the there is a gray offset for the currently 
selected image as shown below. 
 

 

xii. MICR Reader Info 
 
This shows the results returned from the hardware MICR reader.  Any can’t read characters will be 
shown as an *.  When the MOCR Pre-Config option is selected, this line will display the combined MICR 
and OCR results. 
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xiii. Optional OCR Reader Info 
 
The Demo has the ability to enable the use of two additional OCR readers.  OCR reader 1 by default is 
used to read the MICR code line optically.  Both OCR readers can be enabled and configured to read true 
OCR documents if this feature is enabled on the SmartSource Open Professional Series or SmartSource 
Open Adaptive.   

xiv. Pull Down Menus 
 
The main menu that will be used with the Demo is the “Options” Pull Down Menu.  This enables the 
configuration of various options as described in the next section. 
 
 

d. Navigation of Options Pull Down Menu 
 
By clicking on this pull down menu, you will see the following configuration options: 
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i. Endorser Options 
 
When the endorser option is selected the following screen will be displayed: 
 

 
 
By default, endorsing is turned off.  To enable the endorser, you can select one or two options.  By 
selecting “1-4 line print”, you can enter text in the following four lines.  Once you click okay and start 
scanning again, the four lines of text will be endorsed on the back of each item.  You also have the 
option of selecting “1 line with A/N”.  This function will read the account number of the item scanned 
and endorse it on the back of its item.  This demonstrates the ability to make endorsement decisions 
based on the MICR line of each item.     
 
Another parameter called “Offset in tenths of inches” allows you to move the endorsement position of 
the endorsement from the leading edge of the document.  Since this is in 1/10ths of an inch, an inch 
would be entered as 10.  The default setting is 5 or ½ an inch.  Underneath the 4 line text boxes is a 
density setting.  The parameter will let you lighten or darken the endorsement.  The possible values are: 
 

Economy 
Standard 
 Premium 

 
By default, Premium is set for the darkest endorsement of text.    
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The endorser on the SmartSource Open Professional Series / SmartSource Open Adaptive supports 
TrueType fonts. By default, the standard Windows Arial Font is used. The Font option next to the Density 
option displays the list of installed true type fonts from Windows Fonts folder. You can select the font 
you like and apply it for your endorsement.   
 
With the use of the logo option, you can endorse different logos along with text on the back of each 
item.  The files need to be in one of three .bmp formats:  

i) 1 bit-per-pixel bitonal (black/white),  
ii) 8 bits-per-pixel, 256-grayscale (recommended),  
iii) 8 bits-per-pixel, 256-color (color values will be converted to grayscale).  

The height of the logo must be 320 pixels exactly. The width of the logo must not exceed 5696 pixels. To 
use a logo, click on the “Endorse Logo” check box to enable the function. Click on “Browse” to locate the 
appropriate .bmp file you created. Select “Open” to set the logo.  When you start scanning, this logo is 
endorsed followed by your selected text.    You can also set the print density of the logo from a value of 
1 to 5 with 5 being the darkest.   
 
Finally, if your SmartSource Open Professional Series or SmartSource Open Adaptive is configured with a 
Franker, you can enable its use by clicking on the “Stamp/Frank” option.  A Franker is a stamp that 
stamps “Electronically Presented” on the front of each item.  This is similar to the legacy use of a PAID 
stamp on already processed items.   
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ii. Feeder Options 
 
When you click on the feeder options, the following screen will display: 
 

 
 
You have ten options you can set with this menu item.  First, you can select the Flow Type: 

 AutoFeed: The SmartSource scanner will automatically feed all documents in the hopper. This is 
the default 

 Demand Feed: The SmartSource scanner will feed a single item. When that item is pocketed, the 
next item will feed. 

 Single item: The SmartSource scanner will feed a single item, then stop. 
 
if you have a two pocket SmartSource Open Professional Series and have “Pocket on blank code lines” 
checked, items without MICR code line will be out sorted automatically to the second pocket.  This 
feature is checked by default. 
 
By clicking the “Disable start button”, the scanner will start feeding once items are put in the hopper.  If 
you uncheck this box and click OK, then each time you put items in the feeder, you will need to press the 
“SmartClear” button at the top of the scanner to initiate flow.  This feature is checked by default. 
 
By clicking on “Keep items with exceptions”, if you have a jam condition and clear the jam via the 
“SmartClear” button or the Clear Track Button, the MICR code line and front image will be displayed 
even though the item did not pocket.  This demonstrates our ability to take the MICR information and 
front image early in the process and potentially make decisions from them.  If this feature is unchecked, 
then a jammed item will not be displayed.  That way you can review the last good image on the screen 
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to determine which items need to be replaced back in the front of the feeder.  This feature is disabled by 
default and should remain that way for your purposes. 
 
You can use the INI setting (enabled by default) for Double Doc Mode.    
 
The Autofeed timeout is the time in milliseconds between when you click “Start Scan” and the scanner 
initiates flow.  You can reduce or increase this value as you see fit, but the default value should work 
fine. 
 
The size of Adaptive Maximum Page Length can be selected from the three values from the pull down 
list. 
 
For scanner s that have an ID Card Entry point (e.g. , SmartSource Elite), the Flow IDCard setting allows 
the option to switch between flowing from the primary hopper (Flow ID Card “Off” – default setting) to 
inserting items via the ID Card Entry point (Flow ID Card “On”). A third option (Flow ID Card “Any input”) 
allows items to be processed from either the primary entry or the ID Card entry. 
 
For scanners that support cleaning mode, the Cleaning Recommended Document Threshold is the 
threshold for the number of documents that are processed after which the scanner will indicate that 
cleaning is recommended.   This value will be permanently stored in the scanner.  A value of 0 will not 
adjust the threshold, and the scanner will use its previously programmed threshold value. 

iii. Reader Options 
 
When you select the Reader Options, the following screen will display: 
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This shows the three possible readers.  Reader one is the MICR Reader and is enabled by default.  
Readers two and three are OCR readers.  Reader two is set up by default to read MICR optically (MOCR) 
if you enable it.  To enable it, click on the Reader two dropdown and select “OCR Reader1”.  Do not 
change any other values.  Reader three can be customized to read remittance slips if desired by 
selecting the appropriate OCR font and defining the OCR read band area by setting up the Top, Bottom, 
Right, and Left positions.  Readers two and three are disabled by default. If the OCR reader is not 
enabled in the device hardware configuration, the operator should only select the MICROCR.FON 
(MICR/OCR combined) font. 
Enabling the “No spaces” check box will cause the code line being returned without spaces. 
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iv. Image Options 
 
When you select the Image Options function, the following screen will display 
 

 
 
This option allows you to set the order of the image thumbnails shown on the main display window.  By 
default, the front and rear black/white (CCITT) images are first followed by the front and rear 
grayscale(JPEG) images.  Front 1 and Rear 1 are the first two images.  Front 2 and rear 2 are the second 
pair of images.  You can select a different order via the various dropdown boxes.  Front3 provides the 
option to capture high resolution front JPEG images. 
 
The threshold, or image brightness, of each CCITT image can also be set by increasing the values for 
lighter images, or decreasing the values for darker images.  By default, they are optimized.   
 
The JPEG compression quality can be adjusted by increasing the values for lower quality images, or 
decreasing the values for higher quality. By default, they are optimized.  Note: These JPEG settings may 
be overridden by the corresponding JPEGQuality settings in the \Patching\device.ini file. 
 
Three other options are available on this screen.  There is a dropdown box in the lower left part of the 
screen that, by default, shows 240 DPI.  This is the resolution of each image we capture in DPI (Dots Per 
Inch).  You can adjust this value to 200 DPI as an option.  The resolution of the JPEG images will be ½ of 
this value (120 or 100 DPI). 
Another dropdown box is used to detect if a document that has been flipped (the rear of the document 
was imaged by the front camera, and vice versa) and/or rotated (the document was upside down). The 
images for the document will then be automatically re-oriented. Note that this re-orientation process 
may affect document throughput. 
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Finally, there is an edit box for the operator to specify the subfolder name where the images will be 
stored. The subfolder will be under the default image storage location. 
 

e. Image and MICR Code Line File Storage Location 
 
The Demo program saves each of the image types, front black and white, rear black and white, front 
JPEG, rear JPEG, and/or front high resolution JPEG in separate files.  These files by default are located in 
the following directory (this is a hyperlink you can click on to go to that folder location): 
 

C:\SmartSouceDemo\Images 
 

(Note: you have an option to specify a custom subfolder on Image option form. If a subfolder name is 
provided, all image files and code line file will be saved to the subfolder under the above path.) 
 
Once you have processed items and click on the hyperlink, you will see the following screen: 

file:///C:/SmartSourceDemo/Images
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The MICR information that is collected during the capture process is located in the codelines.txt file.  
This file will accumulate all the MICR information from each document processed, even if you clear the 
journal screen or exit the program and restart it.  You can manually delete the file and the program will 
recreate it if you want to only capture a certain set of MICR information or if you want to begin a new 
file. 
 
For the Image files, as you can see by the screen shot above, each image has four files: 
 
F1_00001.tif (F=front, 1=1st front image, .1=1st document, .tif=black and white) 
F2_00001.jpg (F=front, 2=2nd front image, .1=1st document, .jpg=JPEG) 
R1_00001.tif (R=rear image, 1=1st rear image, .1=1st document, .tif=black and white) 
R2_00001.jpg (R=rear, 2=2nd rear image, .1=1st document, .jpg=JPEG) 
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S1_00001.jpg (S=snippet, 1= 1st snippet image, .1=1st document, .jpg=JPEG) if high-resolution JPEG is 
enabled 
 
As stated earlier, by default, you can capture two front image types and two rear image types at track 
speed during capture.  The document number will increment for each item.  Therefore F1_00002.tif 
would be the 1st front image for the second document.  Each set of files is incremented as you capture 
items.  When you restart the program, it will begin at item number 1 and overwrite the previous image.  
You have the option to specify an image folder in the Image Options before each run. You also have the 
option of exiting the program and deleting all the image files from the C:\SmartSourceDemo\Images 
folder; new files will be created when you restart the program. 

f. LED 
 
The operator can set the application LED to Off, Blinking, or Solid, if the attached scanner has an 
application LED. 
 

 
 

g. Restore Default Config 
 
A very useful option is listed under the File Menu as shown below: 
 

 
 
This option will reset everything under the Options Menu to its default value.  This is helpful if you 
change parameters for testing then would like to return them to the default value.   
 

h. Open and Save Config 
 
 

file:///C:/SmartSourceDemo/Images
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As show above with the “Restore Default Config” option, there are two other available options under 
the File menu.  Those are “Open Config” and “Save Config”.  If you make parameter changes that are 
different from the default values you can save that configuration.  This way you can set up multiple 
configurations depending on the type of testing you would like to perform.   
 
Once you have made all the parameter changes you want to save, click on the File menu and choose 
“Save Config” as shown below. 
 

 
 

This screen will be displayed. 
 

 
 

Click on the Make New Folder button on the lower left part of the screen.  This will make a new folder in 
the SmartSource Demo folder.  You can rename that folder to what you like, and then click okay to save 
the folder.  Notice I created one called “Don”. 
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To use the “Open Config” option, select it from File menu and choose the folder name where you saved 
the specific configuration you would like to use.  See the example below a folder has created and is 
called “Don”.  To open that configuration you would choose “Open Config”, click on the “Don” folder as 
shown below and then click OK.  That parameter set is now loaded and can be used once you click on 
“Start Scan”.   
 

 
 

i. Help 
 
An About option is listed under the Help menu: 

 

 
 
The About box displays the Demo program version and copyright information: 
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BARCODE Demo Document 
 
 
 

 

 

               

DIGITAL CHECK UPC-A BARCODE SAMPLE DOCUMENT 
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OCR A/B Demo Document 
 
 


